o e RAM Pages

March 2007
The Official Newsletter of the Fresno PC Users Group

Fresno Personal Computer Users’ Group General Meeting
March 5th, 7:30 PM

Program Will be by:
Jack Borg
of

Earthwide Wireless, ""Professional Wireless Consulting'"

Bills Tricks & Tips

Rename Via F2
Something that saves me a bit of time when renaming files is by enabling

L]
the rename function by pressing F2. It's simple, just select the file to TheA DI‘V e

rename and hit F2. This is much faster than doing a delayed doubleclick or
going through a menu option. Computer Services

Microsoft Word's Insert Button

Have you ever ran into a problem where you move your cursor to edit text on MS Word and when you
type, it ends up overwriting the characters after it? That is MS's over-write function. In case you ever
may need it, tap the "Insert" button on your keyboard or doubleclick on the bottom part of your MS
Word windows that saids "OVR" (for over-write).

Defragmenting The Hard Drive
Defragmenting your harddrive(s) is a task that you must perform if you frequently copy and delete files
(especially small ones) from your harddrive. Essentially, defragmenting the harddrive is nothing more

than rearranging free and used blocks. The idea is that if all used blocks and all free blocks are grouped
separately, searching for files on your harddrive will be faster because all the blocks of a file will be
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grouped together and not scattered all around the harddrive. How data is written in files and on the disk
is complicated to explain in a tip but just take it for granted that defragmentation is a general
housekeeping task and has to be performed regularly.

You can make defragmentation a scheduled task that runs at specified times (i.e. at night when you
computer is idle) or you can start it at any time you like. To start the degragmenter, right-click My
Computer icon on the desktop and select Manage. Then go to Storage and click Disk Defragmenter.
Select the drive you want to defragment and click the Defragment button (or you may first click
Analyze button to see if the drive needs defragmenting or not).

Verify Your CDs and DVDs

It depends on which program you use to record CDs and DVDs but most programs offer an option to
verify the CD or DVD after you have recorded them. Although this takes additional time, verification is
not a step to be skipped. Why? Because if the CD or DVD has errors that make it impossible to read the
data and you do not have the same data somewhere else, it is virtually lost. If a CD or DVD passes the
verification, you can rest assured that the copy is the same as the original. This will save you many
unpleasant surprises later — for instance when you start installing software from a not-properly recorded
CD or DVD.

Google Alerts

If you have ever missed important information because you had not searched the Web for a couple of
days, you will greatly appreciate this Google Alerts. Go to [http://www.google.com/alerts] and log in.
Then choose a search string or a topic that you want to be notified about if new stuff appears in the
search results for this string and topic. For instance, | have several topics that I regularly monitor the
Web about and it is really valuable when I get results delivered right to my mailbox, rather than
perform searches manually and wonder if a particular entry is a new one or not.

Shift+F3 in MS Word

You have typed a whole paragraph of text and now you notice that you have left the Caps Lock on? Or
all of a sudden it dawns on you that in headlines all words start with a capital letter? Don't worry — MS
Word has a really cute keyboard shortcut for changing the case: Shift+F3. The same effect can be
achieved if you select Format -> Change Case. This will open a dialog box you can select how
exactly to change it — to Sentence Case, Upper Case, Lower Case, Title Case or just to toggle the case.

View Folder Bar

The Folder Bar, which displays the folders of your computer in an expandable and collapsible manner,
can be very handy when browsing through the files and folders on your computer. While this feature is
set to appear, by default, in Windows Explorer, it is now shown when viewing My Documents of My
Computer. To make the Folder Bar viewable (from within My Documents or My computer), click on
View > Explorer Bar > Folders. The Folder Bar should now appear in a panel along the left side of
the window.



View Internet History

While in Internet Explorer, one may view a list of recently visited webpages by pressing Ctrl + H or
going to View > Explorer Bar > History. If everything went correctly, a new panel should appear on
the left side of the window. One may now view which sites were recently visited and be able to open
those sites again.

Pressing F4 will also bring up a list of the most recent websites which were typed into the address bar.

Navigate Through A Document

Use the Home and End keys on the keyboard to automatically move to the beginning or end of the
document or Webpage you are currently viewing. One may also use the Page Down (PgDn) and Page
Up (PgUp) keys to move down and up a webpage, rather than using the mouse to navigate through the

page. : .

FPCUG News

Doug Betts of Computer Age Consulting has joined the FPCUG as a
Supporting Business.

Thanks to Don Cummins for his article contribution for this month.

This month's Raffle Item is a DVD/CD Media Kit. This media kit comes with
DVD+R media, a labeling kit, DVD/CD dispenser, a wallet carrier and more!
Raffle Tickets only $1.

Protecting Your Outlook Express Email

Written by Ron Farren, a member of the Keowee Computer Club of Oconee
County, SC

There are, as usual, several ways to protect yourself from a drive failure and
loss of your email. This tip is for users of OE only.

Your email is all stored in a single folder and, if you can find that folder, you will find that it contains a
large number of files. Most of these files will have the extension of ".dbx" if you are configured to
show the extension. Microsoft uses a proprietary format, which makes these files quite difficult to view
except with OE. In addition, the individual files are not useful without the index, which is stored in a
separate file within this folder. If you want to backup your email, it is possible to save the entire folder
someplace. It is relatively easy to copy the entire folder to an external drive or to a second drive.
Should you experience a problem that causes the loss of your email, you can merely copy the folder



back to its original location. Sounds simple enough.

First, you have to find the folder. That is done via Tools > Options > Maintenance. There you can
click on "Store Folder" and it will have the address of the folder you are looking for. You may notice
that it is really buried deep into the system. Now that you know where it is, you can copy that address
for future reference and periodically save the folder as backup. If you are not satisfied with trying to
remember the default location of the messages, it is simple enough to move the folder somewhere else.
For example, you could place the folder directly on the C: drive which would make it easier to find
next time. That can be done by clicking "Change" and following the instructions. An even better
solution is to place the email folder on a separate partition, which prevents it from being destroyed if
you're C: drive should be corrupted by some foreign invader. Changing the location of the email folder
will automatically move all your email to the new location.

So now you know how to save and restore your email. However, there is another step you may wish to
take. Suppose you decide to backup you email once a week or every seven days. Should you have to
restore the backup, you will only lose seven days worth of emails. Would you like to know how to
recapture them, also? The answer lies within the options available in OE. The following will work with
most ISPs although there may be some that do not allow this feature.

Open Tools/Accounts, select the account you are concerned with and select Properties/Advanced. Place
a checkmark by "Leave a copy of messages on server". Now place a checkmark by "Remove the
messages after" and set it to 8 or 9 days. Now place a checkmark by "Remove from server when
deleted from Deleted Items". Now your email server will retain messages for 8 or 9 days. You don't
have to worry about OE retrieving the messages each time you connect to the Internet since OE
maintains an index of downloaded messages and will not download the same message a second time.
However, if you have to restore from a backup, that index will not be up-to-date and the messages will
be downloaded again. By telling the server to delete messages when you have deleted them, that should
reduce the number of messages saved on the server - only the ones you intended to keep anyway.

One additional thought. If you decide to move the email folder, why not move it into My Documents?
If you have already made sure you keep all of your critical information in My Documents, wouldn't it
make sense to put your email there also? Now you can merely copy My Documents to that external
drive once a week and you should be pretty well protected from major disasters.

It really pays to learn how to maintain and protect yourself. Once you have set up a procedure like this,
it becomes something you can easily do once a week and feel more secure.

Computing should be FUN!!!

There is no restriction against any non-profit group using this article as long as it is kept in context
with proper credit given the author. The Editorial Committee of the Association of Personal Computer
User Groups (APCUG), an international organization of which this group is a member, brings this
article to you.



Shopping for free and open source software

By the time you read this, the holiday shopping season will be over and many of you will be trying to
figure out what to put on your new computer. It seems fitting, then, to make a few suggestions of
programs you will find in your Web browser-based shopping center, the Mall of Free and Open
Source Software, or the Mall of FOSS. All of the suggestions made here are suitable not only for
users of Linux and BSD, but also for Windows diehards. In some cases, other operating systems, such
as the Mac and Solaris are supported. So fire up your computer and head on out to the Internet
highway. Oh, and you can leave your credit card at home, for the goods at the Mall of FOSS are priced
most attractively: free.

Screensavers

The holidays are really meant for the child that resides in all of us, and all children want to have fun. So
spice up your PC with some fun items. Start by stopping at the Really Slick Screensavers Web site at
http://www.reallyslick.com/. Here you will find out-of-this-world, mesmerizing screen savers that
range from "psychedelic" to "nauseating." One includes great sound effects. They all perform best with
hardware-based video acceleration, but that should not be a problem with recent hardware. Once you
see these, you'll never go back to the flying Windows or pipes again.

Web browsers

Is your gift recipient still using Internet Explorer? Head on over to http:/www.mozilla.com/ to get
Firefox for him or her. Firefox is a great Web browser with such features as tabbed browsing,
configurable security, extensions that provide additional features, and themes that change the look and
feel. Firefox version 2.0 was released Oct. 24. Or you can shop for a newer browser, Flock, at
http://www.flock.conm/. Flock is based on the same page rendering engine, Gecko, that the Mozilla
family of browsers is built around. But Flock focuses on sharing and connecting with other people
online, with enhanced support for blog posting, RSS feed integration, photo posting on Yahoo Flickr,
and saving your bookmarks on the Internet for sharing between all the computers you use.

Instant messaging

Maybe your giftee spends time in the world of instant messaging. If so, get Gaim, a multi-protocol
instant messaging (IM) client, from http://gaim.sourceforge.net/win32/. Gaim will work with several
different protocols, including AIM, MSN, Yahoo!, Jabber, ICQ and others, so it could become the only
IM client anyone needs. If someone prefers the more traditional Internet Relay Chat (IRC), consider
getting Xchat (http://xchat.org/windows/) or Kvirc (http://www.kvirc.net/) for them.

Juice Receiver

Has someone on your holiday giving list complained about using iTunes on Windows? That person
may enjoy receiving an open source replacement, Juice Receiver, available at
http://juicereceiver.sourceforge.net/. It has access to many of the same podcast indexes that iTunes
provides, as well as a number of indexes that it does not.
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Bittorrent for file swapping

If you have diehard computer geeks on your list, they most likely share files with their friends. The
standard file- swapping protocol is bittorrent, and you will find bittorrent clients for them at
http://www.bittorrent.com and http://www.getazureus.com/. Perhaps they have always wanted to create
their own dynamic Web site but have balked at the price of commercial Web server software for
Windows or the Mac. If so, head over to the XAMPP for Windows store at
http://www.apachefriends.org/en/xampp-windows.html. XAMPP for Windows will give them
everything they need to build a robust, full-featured, dynamic Web site, and it is ready to go out of the
box.

CLAMAYV

Does anyone on your list need or want to try a different virus scanner? The shop at
http://www.clamwin.com/ has the open source scanner, CLAMAYV for Windows, available for you to
give. They'll be getting a GUI-based virus scanner, free and automatic signature updates, and scheduled
virus scanning.

Outlook alternatives

The shops at http://www.mozilla.com/thunderbird/ and
http://shellter.sourceforge.net/evolution/ offer alternatives to the Outlook e-mail
client. The former site has Thunderbird, an easy-to-use product of the Mozilla
project, while the latter provides Evolution, which sports additional support for
calendaring and Microsoft Exchange e-mail servers.

GIMP

Moving on to applications, if there is one on your gift list who does any sort of work with images,
ranging from doctoring photographs to graphics for a Web site, you owe it to them to stop off at
http://www.gimp.org/windows/ and pick up a copy of the GIMP. Somewhat mischaracterized as the
"Poor Man's Photoshop," the GIMP provides a large range of image processing tools and plugins, as
well as a framework for writing custom plugins. With the GIMP, they'll be able to do just about
anything they'd ever want to do to their pictures.

Audacity

Or maybe you are looking for something for someone who is into sound recording, someone who
perhaps was a Mr. or Miss A/V in high school? They undoubtedly would really enjoy receiving the
Audacity sound recorder, editor, and writer. Look for it at http://audacity.sourceforge.net/. This
powerful program literally will turn a PC into a full-featured sound recording and production studio.
Pair it with a professional-quality sound card, and it is hard to beat at any price.

DVD-capable media players
Many of those on your gift list also want to be entertained, and maybe they'd like to watch a DVD
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while working at their computers. A couple of DVD-capable media players they would like can be
found at http://www.mplayerhg.hu/ - which offers the MPlayer media player - and
http://www.videolan.org/ - which offers the VideoLAN VLC player.

Office applications

Chances are the computer users on your holiday gift list use traditional applications such as word
processing, spreadsheets, presentations, and the like. There are several gifts in this category that you
cannot go wrong with. OpenOffice.org is possibly the most popular open source office application
suite available. The latest version, which can be found at http://www.openoffice.org/, is highly
compatible with Microsoft's Word, Excel, and Powerpoint formats, and all but the most complex of
documents can be shared in both directions. OpenOffice.org also supports out-of-the-box export to

PDF and Flash formats.

OpenOffice.org is certainly not the only option in this arena. The Abiword word processor from
http://www.abisource.com/ is a mature product offering a range of features. Since it is a lightweight
user of computer resources, it runs well on older hardware that might bog down under OpenOffice.org,

Microsoft Office, and Vista.

GNUmeric, from http://www.gnome.org/projects/gnumeric/, is a nice, mature spreadsheet program

that has all the options and features your giftee wants for the spreadsheet work. If someone would like
something to help create pretty, Visio-like organizational and flow charts, stop over at http://dia-
installer.sourceforge.net/ and pick them up a copy of DIA, a diagramming tool.

PDFCreator, Scribus

Do your giftees need to produce PDF documents? If so, they'll be grateful to receive PDFCreator,
which is available at . PDFCreator works with any application that prints to the Windows printing
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system, making it easy to create not only PDF
documents, but PNG, JPG, TIFF, BMP, PCX,
PS, and EPS as well. Or maybe they want to
create professional-looking documents like
brochures, booklets, or newsletters. For them,
take a trip to http://www.scribus.net/ and get
them Scribus, a desktop publishing system
with many of the same page layout and
formatting features you expect to find in the
more expensive commercial systems. Scribus
also runs on the Mac.

Web page design

Do you have a Web designer on your giving
list? He or she might like to receive Nvu
(pronounced n-view, and found at
http://www.nvu.com/), a WYSIWYG Web
page editor that will remind you of
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Dreamweaver. With its integrated FTP client, it may be all an e-designer would need. Perhaps they
prefer to develop their Web pages from scratch (or someone on your list might like to get an advanced
text editor). If so, stop off at http://notepad-plus.sourceforge.net/uk/site.htm and pick them up a copy of
Notepad++, which is what Windows' Notepad might be if it consumed strong steroids. It will give your
recipient syntax highlighting, auto-completion, WYSIWY G markup, bookmarking, zooming, multi-
document viewing, and much more.

I hope this gives you some ideas about which stores to look at for your holiday gift-giving needs. And

do not forget the most important person on your holiday gift list: you! If anything here looks interesting
as you read about it, make sure to get yourself a copy. The great thing about all the stores offering
FOSS software gifts is that they always have a great two-for-the-price-of-one sale going on, the perfect
holiday sale.

There is no restriction against any non-profit group using this article as long as it is kept in context
with proper credit given the author. The Editorial Committee of the Association of Personal Computer
User Groups (APCUG), an international organization of which this group is a member, brings this
article to you.

Software Review: Adobe Photoshop Elements 5.0

Nancy Dennis Member of the Sarasota Personal Computer Users Group, Inc.

Adobe Photoshop Elements 5 is a photo editing and organizing program that also includes easy to use
features to backup your photos, and really fun creative ways to show off your photos to family and
friends.

Adobe Photoshop is the top of the line photo program for the professionals and costs hundreds of
dollars. Elements (under $100) has many of the same features as the professional version with a lot of
fun and easy features added in, making it the software choice for the non-professional user like you and
me.

The software installs the Adobe Photo Downloader in your system tray and is ready instantly whenever
you plug in your camera or memory card. Your photos are downloaded into the Organizer where you
have easy access to them for viewing, tagging, creating collections, printing, emailing, creating all the
fun projects, or switching to the Edit mode for a Quick Fix or Full Edit. Your photos are identified by
Elements in Catalogs. You can have multiple catalogs for different users of your computer in the
family, or say for photos that you may use for work which you want to keep separate from home
photos. You can even use the Organizer to select photos to order prints online or size and send through
your email client. Your photos are managed by date with a timeline across the top of the screen that is
very easy to navigate when you are looking for a photo at a specific time on the calendar. The Tags and
Collections feature takes a few extra minutes when you first download the photos, but sure makes it
easier to select certain photos when you are ready to create a project. Tags can be given for photos of
specific family, friends or places and events. Collections work in a similar fashion but could include
several different people, say in a vacation. Since software packages come with little or no manuals, I
find that one of my first places to explore is the Help feature. The Adobe Help Center, which is on the
Help menu, includes a very extensive index of help on the program as well as hyperlinks to video
tutorials on the Adobe web site. The Help Center includes a very good Search tool with easy navigation
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and even a Bookmark feature where you can bookmark a topic that you may want to return to again
quickly. I was also offered free online tutorials from Adobe after I registered the software. Be sure to
take advantage of this offer. There are eleven video tutorials that give a very good overview of
everything from getting your photos into Elements to creating fun creative projects. Another quick way
to get to help on any of the tools on the screen is to hover your mouse over the tool and a link appears
that takes you directly to the Help Center on that tool. You will find that you don't miss the manual
with this complete Adobe Help Center.

When the Elements program starts there is a Welcome Screen where you can choose to open the
Organizer, Quickly Fix Photos, Edit and Enhance Photos, or Make Photo Creations. Once you decide
which mode you want to begin with you can set the Welcome Screen to always open in that mode or
stay with the Welcome Screen. Since you need to open a photo in order to edit it or select several
photos for projects it made sense to me to always open in the Organizer mode.

With a right click of a photo in the Organizer you can select the Go to Quick Fix feature as a truly
"quick fix". With this feature you are able to fix the most common problems with your photos without
having to know any of the more advanced features. Now mind you the advanced features are in
Elements, but you may find that you seldom need to go into that mode to get the results that you want.
With Quick Fix mode you have auto buttons for lighting, color, sharpen and red eye. Then if the auto
button doesn't quite get the photo like you want there are fine tuning levers to adjust to finish the job. If
you just can't get the look you want you can click the Full Edit tab from this window and go into the
more fully featured mode of Elements to complete the task.

Some of the new features for editing in Elements include correct lens distortion, sharpen blurred edges,
fine-tuning with curves, creating dramatic black and whites and support for raw files. One of my very
favorite features of Elements in the Full Edit mode is the Artwork and Effects Palette. From this palette
you can pick from dozens of backgrounds, frames, graphics and shapes. Then select a style for that
object from a dozen more selections and just drag and drop onto your photo. This palette includes
different themes for effects, filters for effects and text styles, all applied with a double click. There is
even a Favorites area where you can R S '
drag an effect that you especially liked ks i ot B it T, i e P o ot
and want to get back to quickly. A == _ g |l
couple other favorites of mine in the ; k. ahE .
Full Edit mode are the Adjust Color for
Skin Tone and the Spot Healing Brush.
If you have a photo where the skin
color just doesn't look right you can
use the Adjust Color for Skin Tone
feature to quickly change the skin tone
by using the eyedropper over the skin.
If you want the result a little more tan
or blush there are easy adjustments in
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an object (or person) from your photo. Again there are fine tuning options in this wizard if the
extraction is not quite what you want. I found that this features works very well. The red eye fix in
Elements 5 is by far the best red eye fix that [ have used in a photo editing program. There is even an
option to have red eye corrected as your photos are being downloaded from the card reader.

Elements 5 has added a Back-Up and Restore feature that allows you to back up your photo catalogs to
a server online (you have to sign up for this service). The online back up service through Adobe
Photoshop Services gives you a 30 day free trial. There is also a Back-Up feature that will do Full and
Incremental back ups of your catalogs to a CD or DVD, another drive, or another folder on the hard
drive. This feature is Wizard driven and makes this very important task quick and easy, without leaving
the Elements software. This feature is right there on the tool bar along with all the other online services.

Once you have your photos downloaded, edited and backed up it is time for the really fun part of
Elements 5 - creating projects like photo book pages, photo layouts, album pages, greeting cards, CD
and DVD jackets and labels, slide shows, VCD's with menus, photo galleries and flipbooks for the
web, photo calendars, and PhotoStamps. Most of the print projects can be printed on your own printer
or ordered through an online service that can be set up with a wizard right in Elements. I didn't register
for the online service but was very tempted by some of the neat projects that can be created and then
sent off for printing and delivery. For instance the photo calendar can be created with 12 of your photos
and then step through the wizard to choose the cover, page layout, and title, etc. Then through the
wizard the calendars will be printed, bound and mailed - what a great idea for Christmas gifts!

I decided to create a slide show with photos taken at Disney World. After selecting the photos from the
Organizer and then selecting Slideshow from the Create menu the wizard started with slide show
preferences and then the main Slideshow Editor opens with very full featured options that are available
in most of the stand alone slide show programs. This feature is like a program within a program - [ am
really impressed with the scope of the Slideshow Editor. There are transition options, panning and
zooming, audio and narration, and adding blank sides and graphics and text.

Once you have the show the way you like it the Output feature opens another wizard for options to save
the show as a file, burn to disc, e-mail the show or send to a TV. The wizard works great burning to a
Video CD format. (The only option that I would like to see added would be to burn to DVD.) If you
have several slide shows that you would like to burn to one CD you can select the Create a VCD with
menu and the wizard will allow you to add multiple slideshows and then create a menu before burning.

The next project I tried was to create a Photo Gallery. With the same Disney photos selected the Photo
Gallery opens a wizard with three types of galleries; Web Galleries, Animated or Interactive. With
Web Galleries chosen the wizard asks for arrangement of the photos on the page and a style with both
options showing thumbnails of how your choice will look. Next the wizard opens a dialog window with
more options to customize, such as Gallery Title and Slideshow duration and effects. You then can
select where to Share the gallery; either choose Do Not Share (which saves to your hard drive),
Photoshop Showcase (more about this later), My FTP Site, or CD. I also tried the Animated and
Interactive galleries with the same photos. The wizard makes creating these very complex shows a
breeze. If you don't know how to publish to your web space a dialog box offers simple steps to help
with that task, or you can register and sign on to the free Adobe Photoshop Elements Showcase feature.
This is an online community for users of Elements to upload and share their photos and galleries.

Each project that you create and save is added to the Organizer at the top. If you want to edit a project
you just double-click the project file and the wizard that was used to create it opens. All of the print
projects like the Photo Book Pages, Photo Layouts and Album Pages, are saved (with multiple pages
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when applicable) with a .pse extension. The print projects are wizard driven and offer step by step
selections for size, layout, theme and then additional options depending on the project chosen. I
decided to make a print project of a CD cover and label for the Disney slide show that I created earlier.
The wizard walked me through the entire process opening Elements in the Full Edit mode with my
selected photo and all the layers in the layer palette created - it truly seemed like magic. Since you are
left in this mode you can then adjust or fine tune the project before saving and printing it.

One feature that I was not able to try but may be of interest to some reading this review is the ability to
download and upload photos from a mobile phone.

I highly recommend Adobe Photoshop Elements 5. There is an upgrade rebate in the box of $20, so if
you are using an older version you can take advantage of that. The price today at Amazon.com is
$69.99 with free shipping and your $20 rebate makes the total price $49.99. There are other special
offers at local stores and online. Visit Adobe's web page www.adobe.com for system requirements.

Book Review: The Photoshop Elements 5 Restoration and
Retouching Book by Matt Kloskowski

Article by Don Cummins

ISBN-10: 0-321-48165-8; ISBN- 13: 978-0-321-48165-8;
Published: Dec 29, 2006;

Copyright 2007; Dimensions

7-1/2 X 9-1/8; Pages: 320;

Edition: 1st.

Matt Kloskowski is the education and curriculum developer for the National Association of Photoshop
Professionals where he eats, sleeps, and breathes Photoshop
and Adobe training to NAPP members. Matt has written four
books on Photoshop and Illustrator including Photoshop CS2
Savvy, Illustrator CS2 Killer Tips, and Extreme Photoshop
CS. He’s featured on various training DVDs available from
www.photoshopvideos.com and is a regular contributing
’_; I o SRS writer to Photoshop User magazine, Layers magazine, and

L S| | /| [ ) ey the Photoshop Elements Techniques Newsletter. Matt is an
Res‘]‘bm‘]‘[,gn & 5 instructor at PhotoshopWorld and the Mac Design

| Re‘]'buehnn o Conference and is an Adobe Certified Expert in Photoshop as
& - well as a Macromedia Flash Certified Developer. He also
teaches basic and advanced Photoshop classes for
sessions.edu online school of design.

This is the book that I have been looking for as most books
only have a small section on how to do restoration and
retouching of mainly old photos. This is the area where most
of all our family photos will need greatest amount of help.
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This is a very complete book on how to bring back to life our childhood pictures (or family photos). If
you do scrap booking for your family history, this is the book you need to have because Matt gives
very good step-by-step instructions on how to repair pictures that may be the only remaining pictures of
your past. If you had to have them done by a camera store, it may be out of sight (price wise) to have
them restored. One example is Matt’s Rebuilding Chapter: Piecing Together a Torn Photo—This a
problem which may be required a lot if you are doing many very old and well handled photos. It is a
fourteen step process which may require a number of other steps that are needed to handle a number of
others things that more than likely go hand in hand with very old photos. Matt has added all the tools
you need to follow his instructions. Another example is How (and Why) to Crop a Portrait. This one
could be used much more often than it is used now and with both new or old photos. It is a seven step
process that can make a good photo into a very good photo. Sometimes we show too much of the
person in a portrait. It should show the person as the main subject with not a lot of excess space. Keep
it simple and in good taste. I feel this cropping tool is over looked too much. But do not overlook the
person’s eyes. Matt feels their eyes will tend to look best when placed in the top third of the photo. At
all times you still must work with the Rule of Thirds.

Place The @ Eyes in the Upper Third

Never Here
or

Below

Photo Grid: If you crop a person and their eyes are in the middle third or the bottom third line, then a
person will typically look like they’re falling out of the photo. We still must follow some of the
standard rules for a good and pleasing photo.

Thank you, Matt, for all of the information in your book, The Photoshop Elements 5 Restoration and
Retouching Book.

I feel this book is very informative and useful for many of my photos which are in need of restoration
and retouching. The price is $34.99 US for Restoration and Retouching Book which is much cheaper
that just having one done by a Photo Restoration person. Plus we could learn some more about our
family history when we do our own restoration.

e o

Essential books for the creative community

If you need books to increase and/or update your photo/computer knowledge, check out Peachpit Press
at www.peachpit.com. We are a member of their users’ group and they have a very nice discount for
users’ group members. Please take advantage of their discounts, promotions, and review copies.

12



Sanity Savers

Sanity Savers are members who have volunteered to help other members with their computing
problems. SIG Leaders are also a valuable information resource.

Do not expect long term counseling, house calls, or to get pirated copies of software recommended to
you. Also do not expect any of the volunteers to help you if you are not the legitimate owner of a
software package.

If you have any experience in an area of computing, feel free to add your name to the Sanity Saver's
list. You do not need to be an expert to be listed as a Sanity Saver--patience and willingness to help
count for a lot.

DOS Dean Mason & Krikor Geyoghlian
Excel Krikor Geyoghlian
General Computing Bill Myers
Internet Help Dean Mason
Audio Help Robert Caraway
Linux Ben Lutes
Lotus 1-2-3 Krikor Geyoghlian
Medical Cecil Bullard
MS Word Krikor Geyoghlian
Office 97/2000/XP Krikor Geyoghlian & Laura Barnard
Windows 3.x Krikor Geyoghlian
The Fine Print

The Fresno PC User's Group (FPCUQG) is a non-profit organization run by and for users of IBM
compatible computers. The only membership eligibility requirement is an interest in computers.

FPCUG meetings are generally held the first Monday of the month at:

Hope Community Center
364 E. Barstow Avenue
Fresno, CA
(Fresno and Barstow)
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FPCUG Officers:

President Bill Myers
1st VP Stan Barnes
2nd VP Jo Townley
Secretary David Smith
Treasurer Wilda Moller
Directors At Large:

1. Regles Bellamy

2. Gary Gipson

3. Monica Braun

4. Brian Fulk

This newsletter was prepared using Macromedia HomeSite 5.5. Ronnie Ugulano is editor.

Contributions.While there's no guarantee that submitted material will be used, contributions to the
FPCUG Newsletter are appreciated. Articles of 200-500 words should be submitted in MS Word doc or
rtf format. Contributions can be in the form of an article written by a member or an article found on the
internet with permission to reprint. Any screenshots or photos should be sharp and high resolution, and
sent as jpgs, bmp, or tiff files, preferably not gifs. Files submitted as pdfs are likely to have their text
and graphics extracted as separate entities so that they can be converted to html format. Graphics might
be cropped or reduced to fit into available space. Contact Ronnie Ugulano for further information.

Reproduction Rights. Original articles may be reproduced by other computer users groups for
internal, non-profit use, provided credit is given to the Fresno PC Users Group and the author(s) of the
reproduced articles. This notice does not supersede the rights of authors whose copyrighted material is
used by permission.

Disclaimer. Trademarks used in this publication are hereby recognized and acknowledged. The
information provided in this newsletter is believed and intended to be correct and useful. However, the
Fresno PC Users Group cannot assume responsibility for errors contained in the articles or
misapplications of the information provided. Unless specifically stated otherwise, opinions expressed
are those of the individual author(s) and do not represent the opinions of, nor endorsement by, the
Fresno PC Users Group. The Fresno PC Users Group is an independent, non-profit users group and is
not affiliated in any way with any vendor or equipment manufacturer.

Vendor Notice. Only review products that have been obtained by the product review coordinator and
received through the FPCUG address shall be considered the responsibility of the FPCUG, unless
otherwise indicated by the Board of Directors and with the full knowledge of the review coordinator.
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